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General Prohibitions

General Precautions

Prohibition to Dismantle the Unit

Prohibition on Subjecting the Unit to Water

WARNING
(Negligence could result in death or serious injury.)

1. Do not dismantle or alter the unit. Fire or electric shock could result.
2. The unit must be installed and wired by a qualified technician.
3. Do not connect any non-specified power source to the +, - terminals, and do not 

install two power supplies in parallel to a single input. Fire, damage to the unit, 
or system malfunction could result.

4. Keep the unit away from water or any other liquid. Fire or electric shock could 
result.

5. Do not connect any terminal on the unit to AC power lines. Fire or electric 
shock could result.

6. Do not put any metal or flammable material into the unit through the openings. 
Fire, electric shock, or unit trouble could result. 

7. Do not install or make any wire terminations while the lift or any other systems 
are powered on. It can cause electrical shock, damage, or malfunction to the 
other systems. 

8. When checking the operation of the lift or other systems, ensure the safety of 
others in the surrounding area before starting. Failure to do so could cause an 
accident.

CAUTION
(Negligence could result in injury to people or damage to property.)
1. Do not install or make any wire terminations while power supply is plugged in. 

It can cause electrical shock or damage to the unit. 
2. Before turning on power, make sure wires are not crossed or shorted. Fire or 

electric shock could result. 
3. Do not put anything on or cover the unit with cloth, etc. Fire or unit trouble 

could result.
4. For DC powered systems, use Aiphone power supply model specified with 

system. If non-specified product is used, fire or malfunction could result.
5. Do not install the unit in any of the following locations. Fire, electric shock, or 

unit trouble could result.
∗ Places under direct sunlight, or near heating equipment that varies in 

temperature.
∗ Places subject to dust, oil, chemicals, hydrogen sulfide (hot spring).
∗ Places subject to moisture and humidity extremes, such as bathroom, cellar, 

greenhouse, etc.
∗ Places where the temperature is quite low, such as inside a refrigerated area or 

in front of air-conditioner.
∗ Places subject to steam or smoke (near heating or cooking surfaces).
∗ Where noise generating devices such as dimmer switches, invertor electrical 

appliances, are closeby.
6. When mounting the unit on wall, install the unit in a convenient location, but not 

where it could be jarred or bumped. Injury could result. 

GENERAL PRECAUTIONS
1. This unit is for indoor use only. Do not use outdoors.
2. As to other systems used with this device, such as the lift, comply with the 

Manufacturer's Specifications and Warranty conditions.
3. The unit turns inoperative during power failure.
4. Keep the intercom wires more than 30 cm (12 inches) away from AC 100-240 V 

lines, particularly AC lines for invertor electrical appliances. Noise and 
malfunction could result.
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1 SYSTEM CONFIGURATION 1-1
System Configuration

a. GH expanded system (For details, see the GH Series 
Installation & Operation Manual.)

Make sure to use GH-BCX/A, GH-DA/A, GH-NS.
[1] Expanded Bus control unit GH-BCX/A
[2] Distribution terminal (junction): Not included
[3] Lift control adaptor GHW-LC

Relay contacts: 20
[4] Bus control unit GH-BC
[5] Power supply PS-2410LC, PS-2410LD, PS-2410DIN
[6] Lift controller (made by other manufacturer)
[7] Lift (made by other manufacturer)
[8] Entrance station (digital name scrolling type): Audio only or Audio/video

Do not use direct selection GH-SW.

∗ For other Wiring Distances, see the GH Series Installation & 
Operation Manual.

Capacity
Lift control adaptor Maximum 16 adaptors (up to 8 adaptors per trunk)

1-2
Wiring Distance

∗ DP = Distribution Point

Diameter of wires

GH-BCX/A ~ GHW-LC -

-

-

-

-

-

-

-

300 m
(980')

300 m
(980')

300 m
(980')

2500 m
(8200')

GH-BCX/A ~ GH-BC

0.65 mm
(22 AWG)

DP ~ GHW-LC

GH-BC ~ DP

GH-BC ~ power supply

Total wiring distance
GH-BCX/A ~ GHW-LC

-

-

5 m
(16')

-

5 m
(16')

0.8 mm
(20 AWG)

1.0 mm
(18 AWG)

5 m
(16')

∗ Capacity of other units conform to the expanded system.

#16

#9

GH-BC

GH-BCX/A

DP

PS24

Max. 8

GH Expanded System

GHW-LC

a

[1]

[3]

GHW-LC[3]

[6]

[7]

[4]

[5]

[2]

1-1

#8

#1

Max. 8

GHW-LC[3]

GHW-LC[3]

[6]

[7]

PS24
GH-DA/A + 
GH-NS, GH-10K

GH-VA + GH-DA/A + 
GH-NS, GH-10K

[8]

or

Common trunk

Sub trunk
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2 CONTENTS

Contents
Lift control adaptor GHW-LC (mounting bracket is included)

3 NAMES

Names
[1] Bus line terminal
[2] ID setting switch
[3] Relay output terminal
[4] Lock release lever

GHW-LC

[1]

[4]

[3]

[2]
[3]
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4 MOUNTING

Mounting
[1] Din rail
[2] Lock release lever
Mount GHW-LC to the Din rail.
∗ To remove GHW-LC, pull the lock release lever down.

GHW-LC cannot be mounted directly to the wall surface.

GHW-LC

[1]

[2]

[1]
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5 WIRING

1P
NP

1P
NP

1P
NP

PS-2410LC PS-2410LD PS-2410DINAC AC
AC

[5]

[4] GH-BC

R14 23 1

R2

[2]DP

R1

R2

+

–

R1

R2

GH-BCX/A

RY20

RY1

GHW-LC

#8

Max. 8

R1

R2

GH-BCX/A

RY20

RY1

GHW-LC

#1

to 
Lift controller

#9 to #16
(max. 8)

1P
NP

1P
NP

1P
NP

1P
NP

1P
NP

1P
NP

1P
NP

GHW-LC

[3]

[3]

GH-BCX/A

[1]
R1 R2
GHW-LC

GH Expanded Systema

+

–

ON

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

#1

#2

#3

#4

ON

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

#5

#6

#7

#8 ON

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

#9

#10

#11

#12

ON

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

#13

#14

#15

#16 ON

1 2 3 4

ID

PS24

PS24

PS24

GH-DA/A + 
GH-NS, GH-10K

GH-VA + GH-DA/A + 
GH-NS, GH-10K

or Common trunk

Sub trunk
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Wiring
a. GH expanded system (For details, see the GH Series 

Installation & Operation Manual.)
[1] Expanded Bus control unit GH-BCX/A
[2] Distribution terminal (junction): Not included
[3] Lift control adaptor GHW-LC

Maximum 16 adaptors (up to 8 adaptors per trunk)
• ID: ID setting switch (factory setting is #1)

Make sure to set corresponding ID number.
[4] Bus control unit GH-BC
[5] Power supply PS-2410LC, PS-2410LD, PS-2410DIN

NP: Non-polarized
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6 SETTING UP Setup tool
∗ Completing settings with the setup tool is required.
1. Install the setup tool in the PC (Windows XP/2000/ME ®) 

beforehand, and then enter the resident information.
∗ For details on the setup tool, refer to the GH Series Installation 

& Operation Manual.
Save programmed data and resident information data to your 
PC is recommended.

2. Connect the PC terminal of GH-BCX/A to the PC with RS-
232C cable (included with GH-NS or GH-MK).

∗ PC requires serial output. If not available, source a USB to 
serial converter and gender changer as needed.

3. Start the setup tool (double-click gh_program.exe).
4. After inputting resident information and clicking OK, the "Lift 

Control 1" tab and "Lift Control 2" tab will appear if "Lift 
Control" is selected in the "View" menu.
If resident information is not input, the "Lift Control 1" tab 
and "Lift Control 2" tab will not appear.

GH-BCX/A

RS-232C Cable

1

2

3

4

6-1
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Lift Control 1
[1] GHW-LC ID
[2] Select "ON" or "OFF" for the GHW-LC connection.
[3] Select "N.O." or "N.C." for the Output Type.
[4] Set the Timer. The time setting range is "1 to 600" sec. (one 

second increments)
• Clicking the upper spin button will increase the time setting, and 
clicking the lower spin button will decrease the time setting. At 
this time, a numerical value exceeding either the upper or lower 
value limits cannot be set.

• The number of seconds can be input directly by clicking inside 
of the Timer box.

• Input can be set by pressing the Enter key or by clicking inside 
of another Timer box.

[5] After GH system settings are completed, the connected GHW-
LC ID numbers will display in black if the "Check" button is 
clicked while connected to GH-BCX/A.
The system will be in use when Connecting status is being 
checked. Checking connections is not possible while the 
system is in use.

Lift Control 2
[1] The resident information that has been entered will be 

displayed.
[2] Set which relay will activate in the corresponding GHW-LC 

for each residence. The setting range is "1 to 20".

Data transfer
1. Select "Export" in the "Connection" menu.
2. If "OK" is selected, the data will be transferred to GH-BCX/A.

[1] [2] [3] [4]

6-2

[5]

[1] [2]

6-3

6-4
1

2
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7 OPERATIONS

7-1

7-2

Residential Station or Security Guard Station Door Release
1. Press the door release button at the residential station or 

security guard station while in communication with the 
entrance station that made a call.

2. The door release function will activate on the entrance station 
that is in communication, and the lift will begin to move.
The lift operates according to the lift controller settings.

∗ In the cases below, the lift will not move.
• If the talk button is pressed and the residential station goes into 
talk mode while the entrance is being monitored.

• When the entrance station access code is input and the door is 
released. In this case, using a proximity card etc. to activate the 
lift to go to their specific floor.

 (This function depends on the lift.)

Automatic Entry (Doctor Call) Option
1. A visitor presses the call button of the entrance station.
2. If the automatic entry is set, the release mechanism is activated 

and the lift will begin to move at the same time.
The lift operates according to the lift controller settings.

• For details on the automatic entry (doctor call), refer to the GH 
Series Installation & Operation Manual.

Combine Data
The data entered in the GH-BCX/A can be combined with the 
data entered in the GH-NS or GH-MK, and this data can be saved 
as master data.
∗ Import the data entered into the GH-NS or GH-MK and GH-

BCX/A before this process.
1. Select and open the corresponding data with "Open" in the 

"File" menu.
2. Selecting "Lift Control" in the "View" menu makes it possible 

to select "Combine Data" in the "File" menu.
3. Select the corresponding data, click the checkboxes for the 

items to be combined, and select "Combine" to combine the 
data. Assign a file name and save.

6-5

3

1

2

1

2

1
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2
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3
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8 TECHNICAL PRECAUTIONS 9 SPECIFICATIONS
Technical precautions

• Operating temperature: 0 °C to 40 °C (32 °F to 104 °F)
• Repair requests: When units do not operate properly, contact a 

qualified technician for service.

Specifications
• Power supply: Supplied by GH-BC
• Relay contacts: 20

AC/DC 24 V, 500mA, N.O./N.C. dry closure 
operation time accuracy �2%

• Wiring: single-pair cable
• Type of cable: Pair cable (solid wire not stranded), 

polyethylene insulated, diameter 0.65 ~ 1.0 mm
• Dimensions: 210 (W) x 108.5 (H) x 61 (D) mm

(8-1/4 x 4-1/4 x 2-3/8 inch)
• Weight: Approx. 330 g (0.7 lbs.)
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AIPHONE CO., LTD., NAGOYA, JAPAN
AIPHONE CORPORATION, BELLEVUE, WA, USA

AIPHONE S.A.S., LISSES-EVRY, FRANCE

http://www.aiphone.com/

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy, and if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures: • Reorient or relocate the receiving antenna • Connect the equipment into an 
outlet on a circuit different from that to which the receiver is connected. Increase the 
separation between the equipment and receiver. • Consult the dealer or an experienced 
radio/TV technician for help.

Aiphone warrants its products to be free from defects of material and workmanship 
under normal use and service for a period of one year after delivery to the ultimate user 
and will repair free of charge or replace at no charge, should it become defective upon 
which examination shall disclose to be defective and under warranty. Aiphone reserves 
unto itself the sole right to make the final decision whether there is a defect in materials 
and/or workmanship; and whether or not the product is within the warranty. This 
warranty shall not apply to any Aiphone product which has been subject to misuse, 
neglect, accident, or to use in violation of instructions furnished, nor extended to units 
which have been repaired or altered outside of the factory. This warranty does not cover 
batteries or damage caused by batteries used in connection with the unit. This warranty 
covers bench repairs only,and any repairs must be made at the shop or place designated 
in writing by Aiphone. Aiphone will not be responsible for any costs incurred involving 
on site service calls. Aiphone will not provide compensation for any loss or damage 
incurred by the breakdown or malfunction of its products during use, or for any 
consequent inconvenience or losses that may result.

WARRANTY

The object area of       (WEEE) is EU.


